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COMING MEETINGS
Prelimary advice only. Subject to change without notice.

Check the website  http://hobartpcgroup.org.au
for the latest information and further details.

8 July 2003 Your home library with Senior Librarian, Warwick Lee
22 July 2003 Outlook 2003 with Mandi Wilson from TasLAN

12 August 2003 TBA
26 August 2003 Annual General Meeting 

9 September 2003 TBA
Updates will be advised via the HCUG-list. Are you a subscriber?

GENERAL INFORMATION

• The Hobart Computer Users Group
Inc. currently meets on the second
and fourth Tuesday of each month
from January to November and on
the second Tuesday in December. 

• We meet at the New Town Senior
Citizens Club rooms, 22-28 Creek
Road, Lenah Valley (opposite Lenah
Valley Primary School).

• We produce a newsletter ten or eleven
times a year, usually in time for the sec-
ond meeting of the month. 

• Doors open at approximately 7.30
pm to allow time to set out the
chairs and set up the computer and
projector. Meetings begin at 8pm. 

• We also run an email list (hcug-
list@southcom.com.au). Members can
use the list to seek help, offer items for
sale and for general discussion.  To
subscribe to the list, go to the URL
below:

• An entry fee of $2 per person
applies.  We regret the necessity of
even this modest charge. However, it
is necessary to cover hall hire,
equipment provision and supper.

http://lists.southcom.com.au/mailman   /  
listinfo/hcug-list

• Visitors are always welcome. Don't
come alone. Bring a friend, or two,
or three.

Your subscription request will be
acknowledged and you must then
reply to activate the subscription.

• Annual subscription is $25.00 per
household per year, payable on 1st

July.  This entitles the household to
one newsletter and one vote.

New service: All members can now have a free permanent email address
e.g. yourname@hobartpcgroup.org.au. Apply now by emailing the Editor!

"Keyboard & Mouse" is published
on the fourth Tuesday each month
and distributed to members,
visitors and advertisers. Copies are
also exchanged with other user
groups in Australia and overseas. 

Editor: Peter Campbell
Asst. Editor: Vacant
Contributors: Cindy Campbell, Peter
Campbell, Bob Curran, Neil Hutton, Ted
Martin
DTP Programs: StarOffice 6.1 beta
running under Windows ME
PDF Conversion: Acrobat Distiller
Printing and collating: The Xerox Shop,
Hobart

The contents of the newsletter are ©
2003  by The Hobart Computer Users
Group Inc., except where reprinted with
permission. All rights are reserved. While
every effort has been taken to check the
accuracy of the contents of this
newsletter, the Management Committee
assumes no liability resulting from any
statements or errors or omissions in this
newsletter or from the use of the
information contained herein.

Permission is given to computer groups
to reproduce material from this
newsletter over which the Group holds
copyright, provided the author and this
publication are acknowledged.
Permission should be sought from the
original copyright holder in respect of
reprinted material.

Views expressed are those of the
individual authors and do not
necessarily reflect the views of the
Group or its Management
Committee.

The Hobart Computer Users
Group Inc. 
PO Box 563 
ROSNY PARK TAS 7018 
Australia
Email: See the Committee List in
opposite column.
ABN: 12 505 486 303

Advertisers please note: 
Deadline for next issue is 9 July 2003. All
advertising copy must reach the Editor by
the advertising deadline, or it may be
excluded at the discretion of the Editor. 
We regret the necessity for this, but
compliance with deadlines is essential so
that the newsletter can be finalised and
printed in time for the second meeting
each month. Advertising rates and
deadlines on application to the Hon.
Secretary.

Visit us at our website: http://hobartpcgroup.org.au for updates, back issues and weekly news



Impress with Impress

Impress is the OpenOffice.org and StarOffice 5.x's
equivalent of Microsoft's Powerpoint. StarOffice 6.x
calls the same tool “Presentation”. It lacks some fea-
tures of the latest version of Microsoft's presentation
application, but is quite suitable for this particular
exercise.

But first, let's consider why you might construct a
website instead of sending the photos as email attach-
ments.

Website vs email 

If you email high resolution photographs, or a large
number of lower resolution photographs to friends as
attachments, those emails will take a long time to
download if the recipient is using a dialup modem. In
addition, you run the risk of so clogging their email
box that other emails cannot be received. They won't
remain your friends for long if you keep doing that to
them!

Of course, if the photographs are compressed, low
resolution, or small ones, you can email them a few at a
time without causing problems.

If you set up a website, you only have to notify
your friends what the website's URL is and they can go
there and download the photograph files directly to
their computer without them passing through their
email box. This gives you the chance to package the
photographs as a slide show, and that is really what
this article is about.

StarOffice 6.x vs OpenOffice.org 1.x

OpenOffice.org is free, and freely distributed, while
StarOffice 6 sells for around $190. Both have a simi-
lar word processor, spreadsheet, presentation pro-
gram and drawing tools. Why, then, would you pay
for StarOffice?

Firstly, StarOffice 6.0 includes Adabas D rela-
tional database, which Sun Microsystems license from
a German company. Secondly, StarOffice 6.0 includes
clipart, templates, AutoPilots (wizards) and photos that
are not included in OpenOffice.org. However, for our

purposes these are not necessary, as we can use clipart
from elsewhere to decorate our presentation.

Support is another consideration, especially in a
business context. OpenOffice.org is not supported,
while StarOffice 6.0 comes with some support included.
Further support and training is available from Sun
Microsystems and its resellers around the world.

New versions

Both StarOffice and OpenOffice.org will be released in
new versions, possibly by the time you read this.
These have been given an improved interface and
many other new features. These are described on
Sun's website so I won't dwell on them here. Suffice it
is to say that you should get the new version, rather
than the old, or upgrade if you already have StarOf-
fice 6.0 or OpenOffice.org 1.0.

Making your presentation

• Click on File, New
• From the menu that opens, choose Presenta-

tion or Impress
• Choose Empty Presentation
• Click Next
• If you are using StarOffice 6.0, you will be

presented with a large number of possible
backgrounds. In OpenOffice there may not
be any. In either case, for Presentation
Background choose <Original> as we do
not need a fancy background for this exer-
cise

• For Output Medium, choose Screen and
click Create

• Name the first slide Introduction and choose
the blank slide as the AutoLayout. You will
see a blank work area representing your
blank slide.

• If there is not a dotted grid showing, go to
Tools, Options and click on the + beside
Presentations

• Click on Grid
• Under Grid, tick Snap to Grid and Visible

Grid
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Making a photo websiteMaking a photo website
Peter Campbell explains how to use OpenOffice.org Impress to make a photo websitePeter Campbell explains how to use OpenOffice.org Impress to make a photo website



• Under Resolution, set
0.50cm as both the
Horizontal and Vertical
Resolution

• Under Snap, tick To
Snap Lines and To The
Page Margins

• Click OK. This will set
a dotted grid that will
help you position the
elements in your title
slides.
Now we are ready to create

our Main Title slide, or Introduc-
tion.

Making slides

At the moment we have a com-
pletely blank, white slide – not a
particularly attractive prospect.
Let's add a background colour:
• Click on Format, Back-

ground
• Choose Color, Gradi-

ent, Hatching or Bit-
map, depending on
what sort of back-
ground you require

• Select the colour or
design

• Answer “Yes” or “No”
depending on whether
you wish to apply that
background to all
slides. I would recom-
mend “Yes” in this case.
Now we need to add some

text to the slide and, perhaps, a
graphic or two. (See Fig. 1)
• At the left of your work

area you will see a
large “T” icon. Hold

down your left mouse
button over it and a
pop-out menu opens.

• Slide your mouse along
to the large “T” on that
menu. Release the
mouse.

• When you bring your
mouse back over the
main work area, the
cursor will change to a
crosshair. 

• Use this to sketch out a
box approximating the
text you wish to insert.

• Type in the text.
• If you want text in

another area, you can
add a couple of line
feeds and change the
font style, as in Fig. 1,
or repeat the process of
making a text box and
typing text into it.

• To add a graphic go to
the Insert menu and
choose Graphics, or go
to the Tools menu and
open the Gallery.

• From the Gallery you
can drag a graphic into
your workspace.

• Note: The graphic will
be in front of any text
that you have already
inserted. Look for the
Arrange icon on the
left. 

• When you hover over
it, the word “Arrange”
will appear. 

• Hold down your left
mouse button to pop
out the menu. Select

the arrangement you
want and click on it.

• Your graphic will be
placed behind the text,
as in Fig. 2. 

• Make title slides for the
various sections of your
presentation, as
required.

• To insert a photo-
graph, use Insert,
Graphics.

• Hold the Shift key and
stretch the photograph
with your mouse until
it is the size required.
(See Fig. 3)

• Place a caption under
it, if required, using a
text box.

Making the website
Converting your presentation to a
website is the easiest part of the
process. Impress/Presentation
does all the work for you.

• Click on File
• Click on Export
• Select where you want

the webpage files
saved. I suggest you
create a new folder for
them to keep them
separate ready for
uploading to your web-
site.

• Name the website pres-
entation index.htm.
Web browsers look for
a file called index.htm or
index.html and use it as
the start page. In a few
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Fig 1: Main title slide with pale yellow
background, active grid, and 'plane

graphic.

Fig 2: Text laid over graphic. Place
graphic first, then text, or use Arrange

button at left or workspace.

Fig 3: Stretch photograph to size by
holding down the Shift key and using

mouse. Sdd caption, if desired. 



cases, the start page
may be called
default.htm or
default.html. If in doubt,
check with Internet
Service Provider for the
correct name.

• Click Save
• You will be asked the

choose a design. Your
choices will decide what
navigation buttons will
be used in your presen-
tation and how the web-
site will be laid out.

• Choose New Design
• Click Next
• Choose Standard

HTML Format. (You
may care to experiment
with the other choices
so that you understand
the differences.)

• Untick Create Title
Slides

• Untick Show Notes
• Click Next
• Choose Save Graphics

as JPG
• Set the Quality. A

higher quality means
bigger file sizes. The
default is 75% but I
found 50% to be a suit-
able setting for this pro-
ject.

• Set the screen resolu-
tion for the monitor
type you expect will
most commonly be
used. The default is 640
x 480 pixels, but 800 x
600 pixels is a more
usual setting these days.

• Untick Export Sound
• Click Next
• Choose one of the four

types of buttons, or tick
Text Only

• Click Next
• Choose the colours to

be used. I suggest you
accept the default set-
tings in this dialogue

box.
• Click Create and your

new website will be cre-
ated.

Uploading your website

To complete your website, you
have to place it online by transfer-
ring the files to a web host. 

Most ISPs give their custom-
ers 5 – 20 MB of space. Some pro-
vide an upload mechanism. With
others you will need to use an FTP
program, such as WS_FTP.

If you need help with the
upload process, consult your ISP's
technical support.

PDF

If you have OpenOffice.org 1.1 or
StarOffice 6.1, you can also export
your presentation as a PDF file.

This could be a good choice if
you are going to distribute your
presentation on CD. The
recipients will need Acrobat
Reader installed, but most peo-
ple now have that. If they don't
they can download it from
http://www.acrobat.com.

The Reader is free and you
could, perhaps, include it on the
CD to save them downloading
it.

Microsoft PowerPoint
OpenOffice.org and StarOffice
can save an Impress/Presen-
tation as a PowerPoint file.
This is another way you could
package a CD of your presen-
tation.
• Click on File
• Click on Save As
• Drop down the Save As

Type menu and choose
Microsoft PowerPoint
97/2000/XP

• Click OK

Recipients of your CD would
not need to have MS PowerPoint
installed, they can download a free
viewer from http://www.micro  -  
soft.com. 

Flash

OpenOffice.org 1.1 and StarOffice
6.1 also offer an Export option of
Macromedia Flash format. This
would be a good choice if you
wanted to automate the show. 

Flash can be viewed by media
players and by web browsers which
have the appropriate plug-in.

If you intend to put your Flash
show on your website, be aware
that it will load much more slowly
than an HTML version. You would
also need to add instructions on
how to change to the next slide,
unless you automate the slide-
changes before making the Flash
presentation. 

KEYBOARD & MOUSE JULY 2003       5

Basic Product List
We can supply a vast range of supplies for your home 

and small business computer users.
Best prices given to members of the Hobart Computer Users

Group Inc. who identify themselves when purchasing.
Even if you only try us for items that others cannot, or will not, 

supply, we will use our best endeavours to do so. 
Combined with friendly and personal service, 

you will be pleasantly surprised.

▪ Computer consumables ▪ Copy paper

▪ Photocopy consumables ▪ Envelopes

▪ Laser consumables ▪ Desk accessories

▪ Printer ▪ Computer paper

▪ Fax rolls ▪ Pens and pencils

▪ Register rolls ▪ OHP Products

▪ Packaging tape ▪ ATM Rolls

"If it's made we can get it"
Please contact Glenn Tanner

Ph  6234 3212  Mob 0419 372 607  Fax 6234 3213

1 Federal Street, North Hobart 7000
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Google to the rescue!
Thankfully I have few problems with my computer but a couple of recent bugs had me scratching my
head. Eventually I used the Google search engine to solve them and was suprised that many others
had been similarly troubled with what I thought were rather bizarre problems.

A few weeks ago I noticed that whenever I opened a file in Microsoft Word [Word 2000] the file opened but the
frame blinked, the file could not be accessed and the program did not respond. I tried Alt-Tab to try to find the answer,
but could not find an info box until I pressed Ctrl-Alt-Del. I then found a box with the words "Do you want to revert to
the saved "filename.doc" ". The only "filename.doc" was the one I had just opened, there was no saved file. On answering,
no, the file was then accessible.

I decided to remove Office 2000 and then reinstall. This seemed to fix the problem with Word, but the next time I
opened a file in Access as soon as the file was displayed on the screen I got an info box with the message: "This patch pack-
age could not be opened. Contact the application vendor to verify that this is a valid Windows Installer patch package." I
was not sure what this meant, but I decided to remove Access and try to install again. This was easier said than done as I
got the same message from Windows Installer, when trying to remove.

I considered deleting all the Registry entries relating to Access, but decided that as there were many hundreds of
entries this was not a practical approach. The best alternative seemed to be search for the error message on the web. To
my suprise and relief this approach turned up many web pages, including a Microsoft page (http://support.
microsoft.com/default.aspx?scid=kb;en-us;Q295823) which suggested using a Windows Installer CleanUp utility
(msicuu.exe for Windows 2000 and XP; msicu.exe for Win95, 98 and ME).

I downloaded and ran the CleanUp program to remove Access 2000 and then reinstalled it, this time with no prob-
lems. However, the next time I opened a Word document I got the "Do you want to ..." message again. Having used Goo-
gle to clear up one problem I tried the same tactic with "Do you want to ..." and again I found that I was not alone and that
others had been similarly plagued. I tried http://csc.calumet.purdue.edu/faq2/printable.asp?q=490. This Purdue Univer-
sity site gave three possible methods to fix the problem, the simplest of which was:

"Method 1: Remove the Microsoft Word Document file type.

1. Quit Microsoft Word, if running.

2. Go to Start.

3. Select Programs.

4. Select Windows Explorer.

5. On the View menu, click Folder Options (Options if you are
using Windows NT).

6. Click the File Types tab.

7. Select Microsoft Word Document and click Remove. [Delete ?]

8. Click OK.

9. Restart Word.

Note: When you restart Word, the application will be re-regis-
tered."

When I examined the entry in the File Types list DOC was listed
as "DOC file" and the option to Delete was greyed out. I pressed the
Restore and the listing was now "Microsoft Word Document". On
restarting Word all was back to normal. Why the DOC file type had
previously changed I shall never know.

Have a nice day!
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Wandering the Web with TedWandering the Web with Ted
Ted Martin uses the Web to solve a baffling problemTed Martin uses the Web to solve a baffling problem
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Do you need it?

Our guest speaker on transferring LPs to CDs regards
PowerPoint and similar presentations as something
used by people who cannot give a talk/lec-
ture/address. 

Not everyone would agree, but using a presenta-
tion as a substitute for a properly prepared talk is not
easy and it is probably best used to enhance such a talk,
not take its place.

Keeping pictures in proportion

Sometimes you need to do some resizing of elements
in PowerPoint/Impress/StarOffice Presentation and
you want to size them so that they all remain the
same size in relationship with each other. This is
done by making sure that when you're resizing some-
thing, that you resize everything at once. If you have
three or four pictures that you have to resize, and
they have to stay the same size in relation to each
other: 
• You click the first picture
• Hold down the Shift key
• Click the other three pictures
• Then you mouse drag the picture to the size

you want.

Save your fonts with your presentation

If you are going to prepare a PowerPoint presentation
that you intend to distribute to others, be sure that
you save this presentation by clicking on the Tools
button in the File/Save As dialogue box. This will
work for most True-Type fonts on the Windows plat-
form.

Saving your toolbar configurations

If you like to customise your PowerPoint UI, move
tool-bars around, configure tool-bars, and tidy up all
the bits and pieces, then you'll want to know that all
this information is stored in c:\windows\application
data\microsoft\powerpoint\ppt.pcb

By copying this file, you can move all your cus-
tomisations to other computers.

Keyboard shortcuts in tool tips

If you would like to see the any available PowerPoint
keyboard shortcuts for menus, commands, and tool-
bar buttons, go to Tools/Customise, click on the
Options tab, and click on "show shortcut keys in
screen tips".

Getting rid of tri-pane view

Sad to say, there is no way to permanently avoid this
recent PowerPoint “improvement”, but you can get rid
of it very quickly by holding down the CTRL key when
you click on the  Slide View button.

Impress and Presentation sensibly don't imple-
ment this controversial view and instead have a choice
of Drawing, Outline, Slides, Notes and Handout views
for your workspace. Click on View, Workspace to
change them, or use the small buttons on the scrollbar.

You can also set a Master view of Drawing, Notes
or Handout by clicking on View, Master.

Using ctrl + drag to copy

You can quickly make a copy of any subject, by hold-
ing down the CTRL key while you drag on the subject.
This will then give you a new copy. This tip works in
almost all Windows applications.

Making slides print correctly

PowerPoint has certain defaults as to how it prints
each object on the page. You can over-ride these
defaults if you feel like it. Go to View/Black and
White; this will show you a grey-scale preview of how
your slide will print. To change the print settings on
any given object, right-click on it, then click "Black
and White", and then choose the print option you
want for that object. Master objects can be selected
by going to the Master page View.
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Bobbie's BestBobbie's Best
Bob Curran suggests some ways to get the best out of your presentationsBob Curran suggests some ways to get the best out of your presentations



In Impress and Presentation,
go to View/Display Quality and
choose from Color, Greyscale, Black
and White, and High Contrast.

Select an object and then right
click on it gives you access to a
menu with many options, including
converting the object to greyscale,
polygons, bitmaps and more. The
choice of options will depend on the
nature of the object. 

Preview slide show effects
While editing a PowerPoint presen-
tation, hold down the CTRL key
while clicking on the slide show
view button; this will open a small
preview window showing that slide
in slide show mode.

In Impress and Presentation,
simply click on View, Preview to
pop-up the small preview window.

Setting the default text
style

If you want to change the style of
text that appears in PowerPoint
when you type things that are not
the title on the slide body, do the
following:

Make sure no objects are
selected. From the Format menu,
select Font. Make all the changes
that you want there, and click OK.
From then on, new text will be
printed in that style.

To set the formatting for the
title or slide body objects, go to the
Slide Master and format these
objects on the master.

Different backgrounds
Users of Power-Point 2000 and any
previous ones, will only have two
background designs automatically
supplied with the Masters (count-
ing both the Slide Master and the
Title Master). However, you can
have any design you want on any
slide. From the Format menu,
select Background. Check the box

that says "omit background
items" and this will make the
slide ignore the Slide Master's
design. You can then place what-
ever design you want on the
slide. 

If you want to do this to a
number of slides at the same time,
go to the Slide Sorter, select the
slides, and then use the Format
menu command. 

But if you choose to put a
photographic background, or
something similar on many of
your slides, instead of doing it
once on the Master, your file size
will increase dramatically.

Power-Point 2002 supports
multiple background masters.

Impress and Presentation do
not support multiple background
masters, but the master back-
ground is automatically over-rid-
den when you set an individual
background for a slide.

To set the Master Back-
ground, go to View, Master and
then Format, Page. Go to View,
Slide to return to the individual
slide view and use Format, Page
to set an individual background.

Using guides to measure

Make the Guides visible by using
View/Guides. Hold down the
SHIFT key while you click and
hold a guide; the tool-tip for the
guide will display. As you move
the guide along, the distance the
guide covers from the beginning
of the drag will be displayed in
the units of your ruler. In this
way you can measure distances
between objects and place guides
at places you want them.

In StarOffice and Open-
Office.org, turn on the grid
(Tools, Options) and use it to
position objects. Snap lines are
being added to the forthcoming
versions (StarOffice 6.1 and
OpenOffice.org 1.1) but are not

working in the beta I'm currently
using.

Slides and text

If you need to create printable
pages that have notes or descrip-
tive text associated with each
slide, Power-Point has a feature
designed to do this, called Notes
Pages, or Speaker's Notes, depend-
ing on which version of Power-
Point you are using. To view the
Notes page for any slide, go to the
View menu and select Notes Pages.
You will see an image of your slide
there, and a place-holder for add-
ing your script, notes, or any other
text you wish. 

You can cut-and-paste text
from Word here if you like. To
print these pages, bring up the
Print dialogue, and at the bottom of
the dialogue where it says "Print
What:", select Notes Pages. These
pages can be designed to be used as
audience hand-outs, and with space
for the audience to take notes, and
can also used as speaker's notes: the
text block would have the script of
the presentation, to be used by the
speaker, or for sales binders to edu-
cated sales people.

Using more guides

If you like using guides, and you
would like a few more, you can
create additional Guides by simply
holding down the CTRL key while
dragging on an existing Guide.
This will create a new guide. To get
rid of guides, just drag them off
the edge of the slide.

Making files smaller

Prior to Power-Point 97, there was
no internal file compression code
inside of Power-Point, and files
could get very big, very quickly.
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The most usual cause of large files
is the addition of large bitmaps.
Power-Point 97 compresses these
bitmaps, but previous versions did
not. 

To keep your presentations as
small as possible, try reducing the
resolution of your bitmaps, which
will bring their size down tremen-
dously. For viewing on screen, the
bitmaps don't need to be more than
96 dpi. They won't print very well
until they are up around 150 or
higher, but the screen will usually
display satisfactorily at 96 dpi, so if
the primary viewing medium is the
screen, there is no point in having
the bitmaps on a higher resolution. 

Also, the bitmap format can
make a big difference to your file
sizes. JPEG and PNG both have
good internal compression code.
GIF has some, but not nearly as
good as JPEG. BMP files are the
largest; TIFF files will also be very
large.

Sometimes, as you're working
on a PowerPoint presentation,
you'll notice that the file seems to
get bigger. To fix this, save the file
using "File/Save As" and give the
file a new name. This can reduce
the file size up to 50%.

Controlling your bitmap sizes
also works in Impress and Presen-
tation. However, they use an XML-
and compression- based native for-
mat, so, unless you need to save as
PowerPoint, use this for smaller
file sizes.

Distribution to others

If you are making a Power-Point
presentation, and you intend to
give it to many different people,
here are a few things to watch out
for that will cause some problems:

1. Stick with the fonts that
come installed with Win-
dows, some fonts that
appear on your machine will
cause problems if everyone

else doesn't have them.
2. Avoid embedding sounds

and videos: these will not
go from Mac to Windows,
and you have to be really
careful about how you
insert the files in order to
get them to "travel" prop-
erly. 

3. Try looking at the presen-
tation from a different
platform, such as Mac vs
Windows, be prepared for
some visual changes in
your file, the version or
platform may not support
some of the features
you've put in, so be sure to
check your file on several
different machines and
versions before you share
it around!
The same rules apply when

designing using Impress and
Presentation. Bear in mind, too,
that some effects may not be pre-
served when you save as Power-
Point. 

Changing case easily

If you have text in PowerPoint
that is in the wrong case, select
the text, and then click Shift+F3
until it changes to the case style
that you want. Clicking Shift+F3
toggles the text case between
ALL CAPS, lower case, and Ini-
tial Capital styles. You will be
surprised how often you use
this little trick once you get
used to it!

In Impress and Presentation,
you can use Format, Character to
open the dialogue box. Then
choose the Font Effects tab and
drop-down the Effects menu. You
will find the four possible options
there and can apply whichever is
needed to make the changes you
want.

If you select an object in
Impress and Presentation and hit

Shift + F3, you will open a dia-
logue box that lets you duplicate
the object, including varying vari-
ous parameters as the duplication is
done.

Nudging objects

In all three presentation programs
discussed in this column, you can
use the arrow keys to move
objects over very small distances.
This is a good move for those lap-
top users who have no mouse.
Select the object, then use the
arrow keys. Each press of the key
will move the object about two
millimetres or so, if you hold down
the ALT key. If you have the grid
turned off, you can move the
objects roughly one pixel at a
time.

Across multiple disks

From the File menu, select Pack
and Go. This wizard will compress
your Power-Point presentation
and copy the file onto as many
floppies as you want. Be sure to
format a few floppies before you
start, and make sure they are
empty. This feature requires Pow-
erPoint 95 or higher.

While there was a similar
utility in StarOffice 5.x, it has been
dropped from the present versions.
In OpenOffice.org 1.0 and
StarOffice 6.0 save your
presentation as a PowerPoint one
and use the free Microsoft
PowerPoint viewer on computers
that do not have PowerPoint
installed.

In OpenOffice.org 1.1 and
StarOffice 6.1, try exporting as
Flash format. You should then be
able to view it in a web-browser,
(subject to the appropriate plug-in
being installed) or with a media
player.
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Two years is enough

One group I belonged to a few
years' back had a rule in their con-
stitution that no member of the
committee could serve more than
two consecutive terms.

That group is no longer
around, but I still think they were
on the right track. Everyone should
take a turn at running the group,
organising meetings, or being
involved in other ways. A voluntary
group where no-one volunteers is a
pathetic thing to behold.

It seems hard to believe that
I've been in the Presidential chair
for two years, but I have and, in
that time, my other commitments
have increased so that I can no
longer give the job the attention it
deserves. Therefore, I am standing
down. So, too, are the Vice-Presi-

dent, the Secretary and the
Caterer.

Replacing such a team in one
hit is going to be hard and would
not have been necessary had there
been less reluctance to be
involved. Peter, for instance,
wanted to stand down two years'
ago and, against his better judg-
ment, was persuaded to stay on.

At times I have felt I have
been banging my head against a
brick wall. The Committee has
worked hard to bring you an
increasing number of guest pre-
senters for our general meetings.
Despite this, attendances have
generally not improved, members
don't go out of their way to per-
suade others to join us, and volun-
teers are thin on the ground.

There is only one good thing
about banging your head against a

brick wall and, to experience it, you
have to stop.

That said, the attendance at the
meeting on 10 June was a signifi-
cant, if temporary, improvement.
Les Courcha was a very interesting
speaker with a real passion for the
subject of copying LPs to CDs and
there were lots of people asking lots
of questions. He has promised to
return and demonstrate the type of
equipment used.

I would like to thank the Vice-
President for chairing the meeting.
In the absence of the Secretary and
the Caterer, I found it necessary to
look after other matters including
the supper. With Peter chairing the
meeting and Kevin Burgess and Bill
Ryan assisting in the kitchen,
things went smoothly, showing
what can be done when people pitch
in to help. 
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Apologies
Apologies were received from Neil
and Kathy Hutton.

Minutes' Secretary
In Neil Hutton's absence, Kevin
Burgess agreed to keep the min-
utes for the meeting.

Confirmation of minutes
The minutes of the previous meet-
ing were read and confirmed after
minor amendments were made.

Matters arising
Peter Campbell reported that the
hard drive from the Group's com-
puter had still not been replaced.
He will follow it up.

The design of membership
acceptance letters and problem
forms has still not been finalised.

Rules of the Association
It was resolved that a further
meeting on 24 June 2003 would
attempt to finalise changes to the
Rules.

Treasurer's Report
The Treasurer did not table a
report but promised to email it to
the Secretary.

Newsletter
It was agreed the new name of the
newsletter would be “Keyboard &
Mouse”. A notice re membership
dues was to be included. Advertis-
ing: Xerox, Essential Office Sup-
plies and Quality Secondhand.

Tribute
The Committee approved the
placement of a death notice in
memory of Peter Clark, partner of
former President, Jenny Hough-
ton. Flowers were also sent and
this action was also approved by
the Committee. Accounts will be
presented later.
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The Hobart Computer Users’ Group
Incorporated

The Annual General Meeting of the Association will be held at 
New Town Senior Citizens Centre, 

22 – 28 Creek Road, New Town, Tas 7008 
at 8.00 p.m. on Tuesday, 26th August 2003.

The Business to be transacted shall be in accordance with Rule 11, of the Constitution and Rules and
shall be conducted in the following order:

1. The reading of the notice convening the Meeting.
2. Apologies.
3. Reading and confirmation of the minutes of the previous Annual General Meeting.
4. Tabling of the President’s Report.
5. Tabling of the Treasurer’s Report.
6. Election of Office Bearers:

President
Vice President
Secretary
Treasurer
Committee (4 Members Required)

7. Fixing of Annual Subscriptions
8. Appointment of Auditor.
9. Approval of new Rules of the Association
10. Any Other Business to be transacted.

 

Notice
Members are reminded that 

annual membership fees fall due on 1 July 2003.

Members wishing to vote on the changes 

to the Rules of the Association are reminded that

they must have paid their fees prior to the

commencement of the AGM.
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